
 

TypeIt4Me
Keen to get to know TypeIt4Me? This user guide is your new best friend.


To get up and running as quickly as possible, dive straight in to the Quick Start section 
for a crash course in the basics of text expansion. Come back to consult the in-depth 
Reference section when you have specific questions.
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1. Quick Start


1.1 - Opening the app


Go to your Applications folder and double click on TypeIt4Me.  
The first time it launches, you will be presented with a window titled 
“Please allow TypeIt4Me to control your computer” (pictured right).


Accessibility access needs to be enabled in order for TypeIt4Me to 
expand abbreviations as you type. Click OK to be taken directly to 
the Accessibility pane in System Preferences, then click the padlock 
and if prompted, enter your administrator password*. Finally, tick 
the checkbox next to TypeIt4Me and log out or restart your Mac 
so that the setting can take effect. 


Please note: until you grant TypeIt4Me this accessibility permission,  
expansion will *not* work when you type abbreviations with the keyboard.  

*If you don’t know your password, this Apple support page may be of some help: http://support.apple.com/kb/ht1274 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1.2 - Getting acquainted with text expansion


TypeIt4Me is a text expander. Text expansion is essentially on-the-fly substitution of short  
typed abbreviations with longer ‘snippets’ of content, which can include lengthy words, phrases,  
boilerplate texts or even pictures. Whenever you type a pre-defined shorthand abbreviation of your  
choosing, TypeIt4Me instantly replaces it with its corresponding snippet. 


Once you’ve granted the necessary accessibility permission outlined in 
section 1.1, launching TypeIt4Me will bring up the main window (pictured). 
This is where you’ll customise the app to your liking and define your own 
personal shorthand. To give you some inspiration, we’ve included a few 
dummy abbreviations you can play with while you get to grips with how 
everything works. When you type these in almost any app that accepts text 
input, they’ll expand to common greetings, contact details and phrases - 
‘snippets’ of text and / or images.


How about trying one of the examples out? With TypeIt4Me running, switch to 
your text editor of choice and type thxem. As soon as you type a space after it, 
this should instantly become: Thank you very much for your email.*


*If this doesn’t happen, it’s possible you didn’t grant TypeIt4Me the accessibility permission it 
requires for keyboard expansion, or you forgot to log out or reboot your Mac after doing so.  
Check the troubleshooting section at the end of this user guide. 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Still with us? Great. Text expansion is a fantastic time saver. Hopefully,  
you’ve enjoyed typing the examples and watching reams of text content  
magically materialise in the blink of an eye. If so, you’ll be pleased to learn  
the fun doesn’t stop there. 


In addition to expanding abbreviations typed on the keyboard, 
TypeIt4Me offers a handy point-and-click option. If, like us, you 
occasionally forget what abbreviation you assigned to a particular 
snippet, or even if you simply don’t feel like typing it, you can scroll 
through the TypeIt4Me menu bar list and click on it, as shown here 
(right). Doing so will insert the snippet contents wherever the 
cursor is currently positioned in the app you’re using.


All good so far? Congratulations, you’ve installed TypeIt4Me on 
your Mac and it’s working as intended. Feel free to try out some of 
the other pre-defined abbreviations in the Examples set to get a 
feel for things before we move on. In the next section of this guide, 
we’ll look at ways to define your own abbreviation / snippet pair. 
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1.3 - Defining your first abbreviation / snippet pair


OK, we’ve had a play with the provided examples and explored the delights of text expansion, so by now you’re 
probably keen to start defining your own shorthand abbreviations. Let’s get down to business. 


1.3.1 Create a new snippet set


First, you’ll want to create your own snippet set, i.e. a file that will contain a new group 
of snippets. Head to the “Sets on this Mac” pane and click the + button below its 
bottom left corner (pictured left). When prompted, give your new set a name (“My 
Snippets”, perhaps) and click Done. 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Once you’ve saved your newly created snippet set, you’ll see it appear in the list,  
along with the bundled Examples set. You’ll notice it’s highlighted, which means it’s 
now the selected set. All the snippets in the selected set are displayed in a list 
below. You’ll also notice a ticked checkbox to the left of the set name. This means 
it’s “active” or, in other words, enabled. If later you want to temporarily disable the 
set, so snippets it contains won’t expand when typed, just untick its checkbox. 


Unlike in older TypeIt4Me versions, multiple sets can be active at the same time. 
You can easily toggle them on and off as and when you need them. You can also 
drag sets to re-order them. Sets higher in the list take priority over the sets below. 
If the same abbreviation is present in more than one set, the one in the topmost 
set in the list will be expanded when you type that abbreviation. 


You don’t have to use multiple sets. The option is simply there for anyone who 
prefers to organise different snippet types into separate groups, for use in very 
specific contexts or applications.


Looking further down, you’ll see that the list of snippets is now empty save for one 
abb / snippet pair. This is a placeholder that is created by default. Try typing abb in 
your favourite word processor or in the body of an email (or just about anywhere 
else). As soon as you type a space* after it, the word abb (i.e. your abbreviation) 
will be replaced by the word snippet. 


*Later in this guide you’ll learn how to change the expansion ‘trigger’ from a space to an alternate 
punctuation key if that suits you better. You’ll also learn to fine tune your preferences to specify 
whether the character that triggered the expansion should be included at the end of the expanded 
snippet or dropped. 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1.3.2 Define a new abbreviation via the main app window


Now that we’ve observed the snappy way TypeIt4Me expands abb to snippet,  
it’s time for you to redefine both abb and snippet to something more useful.  
If you often type the phrase “Thank you so much”, you might want to type  
tysm and have that expand to Thank you so much. Let’s try that, shall we?

First, click on the newly created abb / snippet entry in the list to select it.

Next, press the ⇥ (tab) key. This will move the focus to the abbreviation field. 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Now you can overwrite abb by typing tysm in the abbreviation field…


…and press the ⇥ key again to move to the 
Label field. Here you can choose to give your 
snippet a descriptor, but you don’t have to 
enter anything. While it can come in handy 
for summarising the content of your longer 
boilerplate snippets, for words and short 
phrases you may want to just leave it blank.


Press ⇥ once more to progress to the 
main snippet content editing field*. 
You’ll notice the snippet placeholder is 
highlighted, ready for you to type over 
it with your new content. 


*You may be asking yourself “What’s that pulldown menu in between, though?” Great question. That’s where you can 
choose to create a special kind of snippet that will contain rich text formatting and / or pictures. We’ll come back to that 
and look at it in more detail later in this guide. Don’t worry about it for now.  

Page  of 14 101



Type the phrase Thank you so much in the main content editing field. 


You’ll then want to save the new snippet you’ve just created. There are 
three ways to save changes to a snippet. You can: 


• Use the ⌘-S keyboard shortcut.


• Click anywhere in the adjacent list of snippets.


• Click the Save button in the bottom right corner of the app window.


All done? That was easy peasy, wasn’t it! You’ve just defined a new 
abbreviation / snippet pair without even breaking into a sweat. Now, 
every time you type tysm in almost any Mac app in which you can  
type, it will expand to Thank you so much. Go ahead and create as 
many new abbreviation / snippet pairs as you need. Add new ones or 
delete existing ones using the + and - buttons below the snippets list. 
You can also use the ⌘-N keyboard shortcut to start a new snippet. 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1.3.3 Define a new abbreviation via the Add a Snippet shortcut


We’ve shown you one way to define a new abbreviation and you’ve grasped the nettle with gusto.  
But wouldn’t it be great if instead of doing it that way you could select some existing text, then create 
a snippet and its abbreviation without having to re-type it? Good news: you can do exactly that. 


Imagine you are browsing in Safari and there’s some text in a web page discussing 
Steve Jobs’ myriad successes that you want to add to your collection of snippets. 
For instance, you may want to abbreviate “Apple Macintosh” and have it come up 
whenever you type the letters Appl. 


Begin by selecting and copying to the clipboard the text you want to abbreviate: in 
this case, Apple Macintosh (pictured left). Next, pull down the TypeIt4Me menu and 
click on the Add a Snippet... option as shown below.
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A window will come up prompting you to add a snippet with Appl as 
its abbreviation (pictured right). By default, TypeIt4Me uses the first 
four letters on the clipboard to suggest the abbreviation, but you are 
of course free to change this to something better / more memorable. 
Add a descriptive label if you like, then pick the set to which the new 
snippet should be added (it will default to the currently selected set). 
When you’re done, click the Add this Snippet button and dismiss the 
window. Just remember, if you want to add pictures, you’ll need to 
click the “Rich text / picture” radio button, as illustrated below.


Pretty painless, all in all, no? You may want to consult the Reference 
section to learn how to define a hot key for adding a snippet this way. 
It’ll save you reaching for the menu bar. Otherwise, you now know 
the basics of how to use TypeIt4Me. Feel free to get stuck in and 
come back to this guide later when you have specific questions or 
you want to learn how to craft more advanced snippets.
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2. Reference: What? Where? How?


2.1 - What is TypeIt4me?


TypeIt4Me is a text expander. Text expansion is on-the-fly substitution of short typed 
abbreviations with longer ‘snippets’ of content. These can include lengthy words, phrases, 
boilerplate texts, dynamically calculated dates and time stamps or even pictures. Wherever you 
type a shorthand abbreviation of your choosing, it is instantly replaced with the corresponding 
snippet that you’ve defined. 


The very first text expander released for the Mac platform - actively maintained and developed for 
over 30 years - TypeIt4Me is designed to make typing quick, easy and painless for you. Once 
launched, it runs unobtrusively in the background to help you breeze through your email 
correspondence and swiftly compose your reports, essays, novels, medical notes or legal texts.


Find yourself typing the same things over and over? Build up a set of abbreviations and the full 
text or image ‘snippets' that they represent. TypeIt4Me will save you time and keystrokes by 
automatically expanding them as you continue typing. This works system-wide, almost anywhere 
you can type on your Mac. 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2.2 - “How might I use TypeIt4Me?”


How you use TypeIt4Me will depend on who you are and what you often find yourself writing. It’s 
popular with doctors, transcriptionists, lawyers, customer support teams, coders, journalists, authors 
and bloggers, to give just a few examples. 


Things TypeIt4Me can help you knock out more quickly include:


• people’s names, email addresses and other contact details


• commonly repeated phrases


• awkwardly lengthy / difficult-to-spell medical terms 


• boilerplate clauses for legal contracts


• “Have you tried turning it off and on again?” IT support replies


It can be particularly useful for entering repetitive data in a database file or spreadsheet, or for 
anyone who finds him or herself frequently typing the same things over and over.


 
Many people find TypeIt4Me useful for speedily inserting the current date and a return address when 
composing letters. It’s handy for email sign-offs, too. For example, you might type just br to get: 
Best regards, 
John Appleseed.
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As developers, we use TypeIt4me ourselves to type standard phrases when providing email 
support for our software. It’s great for programming, too. Abbreviations don't have to be shorter 
than the text they produce. For example, we’ve defined tilde (5 letters long) to 'expand' to a single 
character (~), which is often needed in programming, yet always seems to disappear from the 
keyboard when it’s most needed.


TypeIt4Me can save you having to switch keyboards to type in other languages and use special 
characters, accents or symbols. For instance, a US keyboard may not have a readily accessible 
Euro symbol, so  eur could 'expand' to €. When typing in French, ag could become à (a with an 
accent grave). You may find this much easier than typing alt-` + a, or switching between 
international keyboards or long-pressing to pick from an accented character pop-up. 


By defining a set of mnemonic abbreviations for most frequently used words, you can type 
speedily yet more accurately and with less effort. TypeIt4Me will save you keystrokes and 
potentially alleviate repetitive strain injury :)


For example, u r rh ab th cgs could swiftly produce you are right about the changes (if you have 
defined u=you, r=are, rh=right, ab=about, th=the and cgs=changes). 
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2.3 - An overview of the main TypeIt4Me app window


The main app window comprises three core sections. The toolbar is where 

you’ll access your preferences. You can also bring up statistics detailing 
approximately how much time TypeIt4Me has saved you. While you are using 
the app in fully functional demo mode, there is a license button for when you’re 
ready to purchase the app and enter your licence code. That button will go 
away once you’ve pasted in and registered your details.

Below the toolbar is a shallow segment where you’ll create and manage your 
snippet “sets” - data files that contain your snippets and their corresponding 
abbreviations. This is divided into locally stored sets on the left and remote 

sets on the right (more on this later).


The deeper bottom segment is where you’ll create and edit your snippets.  
In the left half is a list of the snippets contained within the currently selected  
set. Select one and its contents will be displayed as a large editable preview  
in the large pane on the right. Above and below these panes are buttons and 
controls for adding, removing, editing, labelling and sorting your snippets, as 
well as an assortment of menus for controlling their individual behaviours 
and crafting more advanced expansion tricks. In the bottom left corner you’ll  
find a help button that when clicked will open this user guide. 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2.4 - How to create your own custom abbreviations


There are two ways to define an abbreviation and its corresponding ‘snippet’. The first involves selecting some 
text, then clicking on Add a Snippet… in the TypeIt4Me menu bar or pressing a hotkey you’ve assigned to that 
action. The second entails creating your abbreviation / snippet pair from scratch in the main TypeIt4Me app 
window. We’ll walk you through both methods.


2.4.1 First method: “Add a Snippet…” from the Clipboard  

Suppose you often close your emails with the words Kind regards,. It’d be easy to remember the abbreviation  
kr as shorthand for Kind regards, wouldn't it? 


To add this entry to your TypeIt4Me snippets set: 


• type out Kind regards, one last time in your email  

• select the text and either cut or copy it to the clipboard (⌘ X or ⌘ C)


• click on Add a Snippet… in TypeIt4Me's menu - or press a hotkey you’ve assigned to this action in 
Preferences.


This will bring up a window in which you'll be prompted to define a custom abbreviation that will represent the 
new Kind regards, snippet that you’re about to create. 
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By default TypeIt4Me will initially suggest that you use the first four letters of the text in the clipboard as your 
abbreviation. While this will sometimes be apt, in this case we’d prefer the abbreviation to be kr, so just type that  
into the abbreviation field instead. Add a descriptive label if you like, then pick the set to which the new snippet 
should be added (it will default to the set you last viewed in the main app window). When you’re done, click the 
Add this Snippet button and dismiss the window with a cmd-W shortcut or by clicking the red close button.

…That’s it! From now on, every time you type kr TypeIt4Me will instantly 
backspace over the abbreviation (kr) and type the full text for you (Kind 
regards,).


Please note: if the text you copy to the clipboard is in rich text format 
(i.e. it contains font, style and colour information) and you want to 
preserve the formatting, make sure the “Rich text” radio button is 
checked. This is necessary for those RTF attributes to be saved when 
you click “Add this Snippet”. If it’s not checked, the snippet will be saved 
as plain text, losing any font, style and colour attributes.


In case you are wondering, the Applescript checkbox is for power users 
who wish to define snippets that execute actions using Applescript 
(more on that later). Clicking the checkbox will insert the special symbol 
that will send the contents of the snippet to AppleScript for execution. 
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2.4.2 Second method: create snippets from scratch


Now we’ll look at how to create a kr —> Kind regards, abbreviation / snippet pair from 
scratch in the main TypeIt4Me app window. Click on Show TypeIt4Me… in the TypeIt4Me 
menu or press a hotkey you’ve assigned to this action in Preferences. The main 
TypeIt4Me app window will pop up.

Click the + button in the bottom left 
corner or use the ⌘ N keyboard 
shortcut. A new default abb / snippet 
placeholder entry will appear in the list 
of snippets. You’ll note the focus 
moves to the Abbreviation text field, 
with the abb placeholder text 
highlighted ready for you to replace it 
with something else.
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+ button…



Now you can overwrite abb by typing kr in the abbreviation field…


…and press the ⇥ key again to move to the 
Label field. Here you can choose to give your 
snippet a descriptor, but you don’t have to 
enter anything. While it can come in handy 
for summarising the content of your longer 
boilerplate snippets, for words and short 
phrases you may want to just leave it blank.


Press ⇥ once more to progress to the 
main snippet content editing field*. 
You’ll notice the snippet placeholder is 
highlighted, ready for you to type over 
it with your new content. 


*You may be asking yourself “What’s that pulldown menu in between, though?” Great question. If you want to apply 
formatting like colour, bolding or italics to your content and / or include pictures, you must first change the “Plain text” 
setting to “Rich text/pictures”.  

Page  of 25 101



Type the phrase Kind regards, in the main content editing field. 


You’ll then want to save the new snippet you’ve just created. There are 
three ways to save changes to a snippet. You can: 


• Use the ⌘ S keyboard shortcut.


• Click anywhere in the adjacent list of snippets.


• Click the Save button in the bottom right corner of the app window.


  


All done? Voilà! Now, every time you type kr in a Mac app in which you 
can type, it will expand to Kind regards,. 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2.5 - How do I get something typed for me?


Once you’ve defined your own shorthand in TypeIt4Me, there are two ways of triggering automatic insertion 
of the text or image an abbreviation represents. The first  - usually the quickest and most fluid - involves 
tickling the keyboard, while the second is a mouse or trackpad affair. This is how it works:


2.5.1 Keystrokes (type your abbreviation)


Type your defined abbreviation, (optionally) followed by a trigger such as a space or punctuation. For 
example, type scf for supercalifragilisticexpialidocious, or adis for antidisestablishmentarianism. Typing re 
could produce Riccardo Ettore. That’s pretty much all there is to it.


In case you’re wondering, if we do define re as an abbreviation for Riccardo Ettore, TypeIt4Me will not 
interfere when we type more or read or area; it looks for the letters re as a separate word, i.e. preceded and 
followed by spaces or by punctuation marks of your choice. It’s worth noting, mind, that when defining 
abbreviations, it's best to avoid potential conflicts with existing words or acronyms. If the first name in the 
example above were Brian and not Riccardo, rather than choose be as the abbreviation it would be better to 
go with something unique like bre. 


If you ever do need to type a letter combo that’s been defined as an abbreviation without it expanding 
(perhaps "re your letter dated the 12th..."), pressing the shift key at the same time as the space bar will 
prevent the space from triggering expansion. So in our example above re wouldn’t become Riccardo Ettore.  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2.5.2 Point-and-click (pick your abbreviation from the menu bar)

If you click on the TypeIt4Me icon in your Mac’s 
menu bar you’ll see that the resulting dropdown 
lists all of your currently active snippet sets. You 
can drill down into each one to reveal the full list 
of snippets contained in each. Click the snippet 
you want and it will be inserted where the cursor 
is positioned in whichever application you’re 
currently using.


This feature can be useful if you occasionally 
forget what abbreviation you assigned to a less 
frequently used snippet. Just scroll through the list 
to find it, click to insert it and carry on typing.


Once you’ve defined an abbreviation, as long as TypeIt4Me is running in the background it will be available 
“on tap” at all times, anywhere text or images can be pasted. It’ll work in your word processor, paint program, 
Finder, Contacts, Safari or just about any app you like. Isn’t technological progress grand? Soon we’ll all be 
reclining in sun loungers drinking cocktails while the machines do everything for us. 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2.6 - What are snippet sets?


In TypeIt4Me, a snippet “set” is a file that contains a group of TypeIt4Me snippets. These sets are a way for you 
to organise and keep different types of snippet separate, should you be so inclined. You can have as few or as 
many sets as you like. If you’re only a light TypeIt4Me user you might decide to use just a single set containing 
all of your snippets. Alternatively, if you have a large number of snippets, you could opt to maintain a number of 
different sets, each one suited to a particular context and / or containing a specific category of snippet. 


Your available sets are listed at the top of the main TypeIt4Me app 
window. When the checkbox to the left of a set’s name is ticked, that 
means the set is enabled or “active,” i.e. when you type an abbreviation 
from that set it will expand to the full snippet. In older versions of the 
software only one set could be active at a time, but as of TypeIt4Me 6.0 
multiple sets can now be active simultaneously. You can easily toggle 
them on and off as and when you need them, by ticking or unticking the 
checkboxes next to the set names. Clicking on a set in the list will 
select it and the snippets it contains will be displayed in the list below, 
so you can browse, edit or add to them.


You can drag sets to re-order them. Sets higher in the list take priority over the sets below; if the same 
abbreviation is present in more than one set, the one in the set that’s higher in the list will be expanded when 
you type that abbreviation. Local snippets in “Sets on this Mac” are treated as ‘higher’ than remote / LAN / 
cloud sets and will always take priority over snippets in sets stored in iCloud Drive, Dropbox etc.
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We start you off with a bundled Examples set to give you some inspiration and provide some sample 
snippets to play with. We also offer some useful pre-cooked sets that you can download from our website 
if you wish. You’ll probably want to create your own in which you’ll save the new snippets you define. 


Here are just a few examples of how you might use sets:


• Switch between an “Office set” and a “Home set”. 


• Keep a separate “Code snippets” set that you only use when you’re programming.


• Organise your snippets into themed groups, e.g. “Names”, “Dates and times” or “Common phrases”.


• If you’re bilingual, you could maintain separate “English” and “Spanish” sets that you would enable as 
and when you need to type in each language.


That last example is where sets can be especially useful beyond merely keeping things tidy and 
organised by common themes. There may be cases in which you might want the same abbreviation to 
expand to something different depending on which set(s) you’re using. For instance, you might have a 
nec abbreviation that expands to necessity when your “English snippets” set is active and to necesidad 
when “Spanish snippets” is active.


In the Mac Finder snippet sets appear as files with the extension “.typeit4me”. Local “Sets on this Mac” 
are stored in a Sets folder in TypeIt4Me’s Application Support folder within your hidden user Library. If 
you have a snippet set file somewhere else on your Mac (e.g. someone has emailed or Airdropped you 
one to use), double-clicking it will automatically move it to the Sets folder and activate it. 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2.6.1 Create a new snippet set


Let’s take a look at how to create your own snippets set. It’s easy. All you have to do is open the main 
TypeIt4Me window - either using a hotkey or by selecting “Show TypeIt4Me…” from the menu - then click 
the + button below the bottom left corner of the ‘Sets on this Mac’ pane (pictured below). 


 
When prompted, give your new set a meaningful name (“My Snippets”, 
perhaps) and click the Done button or hit Enter / Return to save it. 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Once you’ve saved your newly created snippets set, you’ll see it appear 
in the list, together with the bundled Examples set. You’ll notice it’s 
highlighted, which means it’s selected and the snippets it contains will be 
displayed in the list below it. You’ll also notice the checkbox next to the 
set name is ticked; this means it is now an active set - that is, all snippets 
added to this set will be expanded wherever you type the abbreviations 
that represent them.


Remember, as of TypeIt4Me 6.0 multiple sets can now be active 
simultaneously. You can easily toggle them on and off as and when you 
need them, by ticking or unticking the checkboxes next to the set names. 
Again, you don’t have to use multiple sets if you don’t want to, it’s entirely 
up to you. The option is simply there for anyone who prefers to keep 
different snippet types in separate groups, for use in specific contexts.


…It probably hasn’t escaped your attention that there are two panes for 
sets and that the one on the right is headed “Remote sets”. This is a 
much requested feature previously only available in the Mac App Store 
version for use with iCloud. TypeIt4Me can make use of network 
connectivity and cloud storage services to enable you to use the same 
snippets on multiple Macs and keep them in sync. We’ll explain this 
further in section 2.6.2  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2.6.2 Sync snippets via the cloud, or use a shared network folder


In Preferences you can enable iCloud Drive sync, or you can point TypeIt4Me to your Dropbox, 
Google Drive or other cloud-linked folders, or select a shared network folder in which to store your 
snippet sets. Doing so gives you the option to use the same snippet(s) on multiple Macs and keep 
them in sync across all your machines even as you add new ones. Enabling remote sets and 
specifying which cloud-synced or shared network folder you’d like to use is explained on page 90. 


When you point to a cloud-synced folder or specify a shared network folder to use, it’s activated in 
the pane to the right of “Sets on this Mac”. You can then create new sets in your chosen folder 
using the + button on the right or move local sets to it by dragging them across (pictured below). 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1. To move a snippet set from the local Sets on this Mac pane to your 
preferred cloud sync or shared network folder, just drag it across.

2. Your snippet set will now be shared with any other Macs you have 
set up to use the same sync option in TypeIt4Me.



2.6.3 How to get to a snippet set file in Finder


There may be times when you want to do something directly to your set file(s); perhaps you’ll 
want to make duplicate backup copies to archive for safekeeping, or you might want to email or 
AirDrop them to a colleague so s/he can use the same snippets. The folders in which snippet set 
files are stored on your Mac are hidden by default, but there is an easy shortcut that will take you 
straight to the file you want in the macOS Finder from within the TypeIt4Me app. Just ctrl-click on 
the name of a set in the list and then click on the “Reveal in Finder” context menu that pops up.
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2.6.4 How to copy snippets from one set to another


Sometimes you may want to copy snippets between sets. You can do this quite easily. Just hold 
the command (⌘) key and select the snippets you want to move by clicking on them. Copy them 
to the clipboard (⌘ C). Navigate to the other set you wish to add those snippets to. Then click 
once anywhere in the list of snippets in the new set and paste (⌘ V).  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1. Select the set that contains the snippets you wish to copy to 
another set. ⌘-click on the ones you want until you’ve selected 
them all, then press ⌘ C to copy them to the clipboard.

2. Switch to the target set, then click once anywhere in the list of its 
snippets and ⌘ V to paste the snippets you just copied from the 
previous set into this one. They’ll be added to the bottom of the list, 
so you may need to scroll down to see them



2.6.5 How to import existing snippet sets from other software


TypeIt4Me was the first text expansion program for the Mac, but these days it’s far from the only 
app of its kind. If you have previously used similar software, then you may have already built up a 
large library of shorthand abbreviations. We don’t want you to have to re-create them all from 
scratch, so to save you some time TypeIt4Me can import snippets you’ve exported from other 
apps in CSV format. Text snippets will be converted in bulk for you, so all you’ll need to do is 
manually tweak any that contain proprietary date / time code, special formatting or placeholders / 
fill-ins to use the equivalent TypeIt4Me syntax in order for those special snippets to work.


Import CSV files using drag-and-drop:


If your old software supports it, save your existing snippet file(s) in comma 
separated value (CSV) format, then drag and drop your exported .csv file(s) 
onto the “Sets on this Mac” pane to import. All that remains to be done then is 
to re-apply any required rich formatting and perhaps make manual tweaks to 
any special dynamic date and time snippets to use TypeIt4Me syntax.


If you’re coming from TextExpander 6, follow the instructions at the Smile 
Software website to export your snippets in CSV format then open it in 
Numbers and use Find & Replace to strip out the HTML tags Smile uses for 
rich formatting. Alternatively, if you have snippet data files in the older 
TextExpander 5 format you can skip the CSV conversion step. Just drag 
TextExpander 5 files straight into the “Sets on this Mac” pane in TypeIt4Me. 
Text snippets will be converted automatically (minus rich formatting and any 
descriptive labels you had assigned to them). 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2.6.6 How to restore “Sets on this Mac” from a Time Machine backup


The Mac may be one of the greatest inventions since sliced bread, but things still can and do go 
wrong, sometimes. A sudden hard drive failure or a careless click on a delete button can result in 
an unexpected loss of data. We’ve all been there. Fortunately, the good people at Apple gave us 
Time Machine, so we can back everything up to an external drive in case we need to rescue lost 
data. If something happens to your TypeIt4Me snippets but you regularly back up the contents of 
your Mac, it will usually be possible to recover them. You can use Time Machine to restore 
TypeIt4Me sets like you would any other files.


Local "Sets on this Mac" snippet sets are stored in ‘~/Library/Application Support/TypeIt4Me/Sets/'


Note that the files are stored in your *user* library, which is not normally visible in Finder as Apple 
hides it by default. To restore a local TypeIt4Me snippet set from Time Machine:


1. Connect your Time Capsule or other external backup drive.


2. Click on Go in the Finder menu bar.


3. Hold down the alt / option key on your keyboard.


4. Click on Library when it appears in the open Go menu.


5. Navigate to Application Support > TypeIt4Me > Sets


6. Launch Time Machine.


7. Navigate to the most recent backup of the Sets folder(s) you want and restore.


Tip: If your snippet set appears to have suddenly disappeared, before resorting to Time Machine, look in your Trash. 
Your set may have inadvertently been moved there. Is there a file in there that ends with the extension .typeit4me? If 
so, drag it back out and double-click it to re-import it into TypeIt4Me. 

Page  of 37 101



2.6.7 How to restore iCloud Drive snippet sets


If something happens to your iCloud TypeIt4Me snippets but you regularly back up the contents of 
your Mac, it will usually be possible to recover them. As of TypeIt4Me 6.3, local copies of your 
iCloud TypeIt4Me sets are stored in the browsable iCloud Drive directory on your Mac. You’ll find 
them inside a container folder named TypeIt4Me that’s branded with the app’s icon. You can use 
Time Machine to restore sets backed up from this container folder, like you would any other files. 


If for any reason the usual Time Machine restoration process fails, there is another fall back 
option. TypeIt4Me regularly creates archived copies of your iCloud sets at weekly intervals that 
are saved to its local Application Support folder for emergency rescue purposes. If you lose or 
accidentally delete an iCloud Drive- stored set, this is what you should do: 


1. Click on Go in the Finder menu bar.


2. Hold down the alt / option key on your keyboard.


3. Click on Library when it appears in the open Go menu.


4. Navigate to Application Support > TypeIt4Me > Archives > Remote


5. Locate the archived copy of the snippet set and double-click it. It will automatically be 

moved and will re-appear in TypeIt4Me under “Sets on this Mac.”


6. In TypeIt4Me drag the set back across from “Sets on this Mac" into “Sets in iCloud Drive.”


Tip: If your iCloud snippet set has suddenly disappeared, before resorting to Time Machine, try this: in TypeIt4Me, 
create a temporary new set in “Sets in iCloud Drive” then control-click on it and select “Reveal in Finder” from the 
context menu that pops up. This will take you to the .typeit4me file you just created in a Finder window. If you also see 
your missing set file listed in that window, with a cloud icon next to it, click once on the cloud icon to re-download the file 
from Apple’s server. Quit and restart TypeIt4Me and that set ought to show up again in “Sets in iCloud Drive.” 


Page  of 38 101



2.7 - Where and when does TypeIt4Me type?


Technically, the “typing” that TypeIt4Me performs when it expands one of your abbreviations is 
usually a “paste” operation. It will occur wherever you are currently entering text, be it in a word 
processing document, an email message, a save dialog, a folder or file name field, a database 
entry field and so on. 


A snippet - which can be text and / or picture(s) - will be pasted wherever the cursor is currently 
positioned when you do one of the following things:


• you use your mouse or trackpad to “pick” it from a list in TypeIt4Me's point-and-click menu


• you type the abbreviation associated with the snippet (optionally) followed by any of up to 35 
potential trigger characters. The default trigger is a space.


If you go to the Triggers tab in TypeIt4Me’s preferences, you can define exactly what characters 
should act as triggers. You can also choose to have no triggers, in which case your abbreviations 
will expand as soon as you type them. To do that, just click the “None” button at bottom right.


When expanded, snippets that were defined and saved as plain text will match the font and style 
of any text immediately preceding the point at which you insert them. “Only “rich text” snippets will 
preserve the formatting with which they were originally saved, wherever you expand them.
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2.7.1 Compatibility issues with other third party software  

TypeIt4Me works with the vast majority of third party applications that accept text input. That said, 
while it’s rare, conflicts can occasionally arise and you may encounter compatibility issues once in 
a while. The automatic “typing" of your snippets is achieved by temporarily placing the snippet 
contents on the clipboard and issuing a Paste (⌘ V) command. Some apps are built in such a 
way that they can’t handle pasting in certain text fields and this can prevent TypeIt4Me from doing 
its job. It’s also possible that third party apps and utilities for managing or extending the 
functionality of the clipboard could interfere with TypeIt4Me expansions.


If TypeIt4Me ever appears to fail, try doing a "manual" paste (⌘ V) into the text field in which 
you’re typing and see if that works. If it doesn't, then the developer of the software in question has 
built it in such a way that it will prevent TypeIt4Me from working. This is the case in some versions 
of Entourage, to cite one example. You cannot expand an abbreviation in the save dialog that 
follows Save as PDF in Entourage’s Print dialog. Meanwhile, the same operation works fine in 
Apple’s TextEdit and Mail. If you run into a frustrating issue like this and consider it a deal-breaker, 
your best bet for resolving it is to contact the developer of the software you’re using and request 
that they support pasting into the field in question, so that it will play well with TypeIt4Me.


2.7.2 Password entry


Nowadays, password entry fields are typically protected against programs trying to "sniff" what 
you type into them using a mechanism known as Secure Input. This temporarily prevents 
TypeIt4Me from working. For example, entering a TypeIt4Me abbreviation directly in a password 
field in Safari will not result in expansion of the snippet. All things considered, given today’s 
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increasingly risky digital security landscape, this is A Good Thing - we wouldn’t encourage you to 
store sensitive passwords as unencrypted, plain text snippets. 


It’s far more secure to use Safari’s keychain or a dedicated third party password manager app to 
handle your online logins, as these can offer a sophisticated level of protection. However, if you 
really want to - perhaps you have a low-risk ‘throwaway’ account you frequently log in to and 
you’re not concerned about it potentially being compromised - you can use TypeIt4Me to enter 
passwords for you. 


Entering passwords with TypeIt4Me


Create an abbreviation, e.g. pw, and define the snippet as 
username⇥password⏎%- using the Insert > Special menu 
to insert the ⇥, carriage return and Don’t Append Trigger 
symbols. On a login page in Safari, typing the abbreviation 
and expansion trigger into the username field will submit your 
login details for you. 


2.7.3 Secure Input


From time to time - typically when filling in forms on web pages - you may see notifications from 
TypeIt4Me appear in the corner of your screen and / or in Notification Centre. These are to inform 
you that an app you’re currently using (most likely a web browser) has enabled something called 
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Secure Input and that this will stop TypeIt4Me from working. Secure Input is a powerful 
protective feature built into macOS that many apps and websites use to shield your passwords 
and other sensitive data while these are being entered. This is so that they can't be intercepted 
and recorded for nefarious purposes and only you will know what you're typing. Secure Input is 
very much a good thing and it's a crucial defence against data theft, however it is meant to be 
used sparingly. It can cause problems if it isn't turned off again once it's done its job. 


For as long as it’s enabled, Secure Input will prevent TypeIt4Me from working


In some apps, when the Secure Input protection is triggered it can erroneously remain enabled 
even after you're done entering the sensitive information and / or you switch to a different app. 
TypeIt4Me and other text expansion apps will then be 'locked out' of keyboard input, unable to 
see what you’re typing and prevented from functioning until Secure Input is turned off. 


It’s important to note, though, that when a TypeIt4Me notification appears and alerts you that an 
app has enabled Secure Input, that doesn’t necessarily mean that expansion will no longer work 
until the app in question is closed. Rather, its purpose is to make you aware of the last app(s) that 
recently switched Secure Input on, in case you then find text expansion no longer works and you 
need to identify which app may have left Secure Input enabled for too long.


How to resolve the Secure Input issue and get TypeIt4Me working again


If Secure Input stops TypeIt4Me from working you'll need to identify the app that has left Secure 
Input enabled and quit that app. Doing so will enable TypeIt4Me to resume expanding your 
abbreviations as normal again. If you can’t remember what the last alert or banner said, check 
your Notification Centre to see if there are any TypeIt4Me messages in there to help track down 
the app that’s responsible. 
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It's often a web browser such as Google Chrome or Firefox that leaves Secure Input enabled, 
though there are known issues with other software too, including VPN apps, antivirus clients and 
popular password managers such as 1Password or Lastpass. If none of those looks to be 
responsible, it could also be down to other third party apps like Authy, Slack, Fluid, Hulu Desktop, 
iFinance, Quicken Scheduler, Chronories or Notational Velocity. If you're a command-line tinkerer 
you might also want to ensure that Terminal's 'Secure Keyboard Entry' is turned off when you're 
done entering a password.




How to stop Secure Input warnings


Secure Input is a core functionality built in to macOS and can’t be completely 
disabled or bypassed. If an app wants to turn it on, there’s no stopping it; 
TypeIt4Me has no control over that. But if notifications become so frequent and / or 
irritating that you’d rather not see them, it’s easy to stop them from appearing. 
Open your Mac’s System Preferences and click on Notifications. Once you’re in 
Notifications you’ll see a list of apps on the left. Select TypeIt4Me in the list, then 
toggle the “Allow Notifications” switch to the off position.


Turning off all notifications is not something we recommend, however, as they can 
provide invaluable clues to what’s happened should TypeIt4Me expansion stop 
working all of a sudden. If you just want to make notifications less intrusive so they 
don’t distract you, we suggest that you leave “Allow Notifications” and “Show in 
Notification Centre” switched on, while turning off alerts and sounds. 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2.8 - How do I stop TypeIt4Me from typing stuff for me?


Sometimes you may want to stop TypeIt4Me from doing its thing, for one reason or another.  
Of course, you could quit TypeIt4Me altogether, but you may find it more convenient to leave it 
running and just selectively stop it expanding abbreviations. There are a few ways to do this. 


2.8.1 One-off keyboard expansion blocking


The default trigger for expanding an abbreviation is typing a space after it. If ever you want to type 
an abbreviation as part of a sentence without TypeIt4Me expanding it, all you need to remember 
is to hold down the shift key as you type the space after it. Doing so will prevent expansion.


2.8.2 Temporarily pause TypeIt4Me

If you want to type continuously for a few minutes 
without any interference by TypeIt4Me, you can 
temporarily pause automatic expansion of typed 
abbreviations. To do this, select the Pause option 
in the TypeIt4Me menu. A small " symbol on the 
TypeIt4Me icon in the menu bar will denote that 
the app is in pause mode. 
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When you’re ready for TypeIt4Me to carry on 
expanding your abbreviations as normal, just 
select the Resume option.


2.8.3 Disable keyboard expansion indefinitely

If you’re after a longer term solution that switches typing expansion off 

indefinitely - even across system restarts - you may wish to check the 

“Disable keyboard expansion” box in TypeIt4Me’s Preferences. To find 

this, click on Preferences and navigate to the Expansion tab. It’s the first 

option in the list on the left.


While this box is checked in Preferences, nothing you type will ever 

be expanded. However, you’ll still be able to use the point-and-click 

menu list to insert snippets, should you need them. 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2.8.4 Disable TypeIt4Me expansion on a per-app basis

There may be certain apps in which you never want expansion to 
occur. To that end, you can selectively disable TypeIt4Me on a 
per-app basis. 


All you need to do is go to TypeIt4Me’s Preferences, navigate to 
the Special tab and add those apps you’d like to exclude from 
expansion to the list of apps that require special behaviour. Just 
click the + button at bottom left and select an app to add to the 
list. You’ll see that the default special behaviour is to not expand 
snippets, so you can leave that as it is. (The other option is to 
expand using only one specific set when using a certain app.)


Once you’ve added the app(s) you’d like to exclude just click 
Done and from that point on, TypeIt4Me won’t expand any of 
your snippets when you’re working in that particular application. 


If you later change your mind, just return to the Special tab in 
Preferences, click the app in the list to select it, then use the - 
button at bottom left to remove it.  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2.9 - How to include pictures, styling and hyperlinked text in snippets


2.9.1 Add a picture to a snippet


It’s likely you’ll mainly be using TypeIt4Me to expand abbreviations to long words and phrases, 
but in addition to text, snippets can include pictures. You might, for example, create an email 
sign-off snippet that contains a scanned picture of your signature. Or, you could create a 
snippet that inserts a drawing when you type the abbreviation that represents it. 


To include a picture in your 
snippet, you first need to click the 
“Snippet contents” pulldown menu 
and change the content type from 
“Plain text” to “Rich text/pictures” 
(as in the screenshot to the left).


Once you’ve done that, place the cursor in the main snippet editing box. You can then either 
drag & drop or copy and paste pictures into the snippet. Most common formats will work (gif, 
jpeg, png, tiff, et al.) but do keep an eye on the file size of your images. If you accumulate an 
extensive snippet library containing lots of very large, high resolution images, this can slow 
TypeIt4Me down.
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2.9.2 Apply formatting to the text of a snippet

When “Rich text/pictures” is selected from the 
“Snippet contents” pulldown menu, you can apply 
formatting to any of the text in your snippet. Font, 
colour, bolding, italics, underline and other 
attributes can all be adjusted to your heart’s 
content. To change any of these you can either use 
standard keyboard shortcuts or pick from the 
Format menu, as pictured here. 


TypeIt4Me offers considerable flexibility when it 
comes to formatting your snippets. Have a play 
around with the various options and try mixing and 
matching different styles.


If you want all rich snippets you create from scratch 
to default to a particular font, size and colour: first 
create a snippet and apply the font attributes you 
want, then select all or part of the text and choose 
“Use as default” from the Format menu.  
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One caveat to note: not all apps in which you type will honour the rich text formatting 
you’ve applied to your snippets. You will likely encounter a few that take it upon 
themselves to strip out some or even all attributes, or that force the expanded text to 
match the formatting of immediately preceding content. 



2.9.3 Include hyperlinked text in a snippet


Sometimes, you may want to include some hyperlinked text in the body of a snippet that will open 
a web page when clicked. Perhaps you’d like your email signature snippet to contain a link that 
goes to your website, for example. While you can’t create an active hyperlink from scratch within 
the app itself, TypeIt4Me does support hyperlinks in snippets. 


To include a hyperlink:


1. Select and copy some hyperlinked text from an email or web 
page to your clipboard. 

2. Create a new snippet and select “Rich/text pictures” from 
the snippet contents pulldown menu. 

3. Paste your hyperlinked text into the snippet editing box, 
add any further text or other content you wish to include, 
then save.


That’s all there is to it. Now when you type the abbreviation in 
apps that accept rich text and / or hyperlinks, the hyperlinked part 
of the snippet will remain clickable when it’s expanded. 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2.10 - How to limit an abbreviation to a specific app


In certain circumstances you may wish to specify that an abbreviation should only expand 
when typed in one specific app. To do this, just click the icon in the “App” column to the left of 
the abbreviation; this will open a menu in which you can select the app to which you’d like to 
confine the abbreviation.


Say for instance we want the abbreviation ds to expand to Dear Sir, but only ever in the Apple 
Mail app and nowhere else. In order to specify that, just do the following:
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1. Click the app 
icon to the left of 
the ds abbreviation
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2. Double click on the 
Mail app in the popup 
dialogue to associate it 
with the abbreviation



Once you’ve done that, you’ll notice the previously generic app icon (that denotes an 
abbreviation will expand in all apps) has been replaced with the Apple Mail icon. This 
means the abbreviation will now only expand when typed in that particular app.

To clear an association, just click once on the app icon to the left 
of an abbreviation and confirm your choice when prompted.
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2.11 - Labelling snippets


Snippets can optionally be assigned labels to help you identify them in the 
TypeIt4Me menu. If you only ever use typed-at-the-keyboard expansion you 
may not want to bother with it, but it can be a useful feature if you do find 
yourself manually picking snippets from the menu.


For example, you might have two phone numbers: one for personal calls 
and the other for office-related matters. Instead of showing up in the menu 
as two confusingly similar multi-digit numbers, they could appear as clearly 
distinguishable work and personal numbers. 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Two similar numbers  
with no labels…

For each snippet, type a memorable descriptor in the Label 
field to help distinguish it from others that may be similar.

Two clearly labelled  
number snippets…



2.12 - Displaying snippets in the TypeIt4Me menu


Let’s take a look at the point-and-click menu TypeIt4Me offers as an 
alternative to expanding abbreviations as they’re typed. By default, this 
lists all the snippets in the currently active sets, showing the abbreviations 
alongside the labels if you have labelled them, or all or part of the snippet 
content if you haven’t. You can change this and assign different 
behaviours to individual snippets. It’s possible to display none, some or all 
of your abbreviations in the menu, setting each one to show just the 
snippet, just the label, both or nothing at all.


To change the way a snippet is displayed in the TypeIt4Me menu, bring 
up the main app window and click on it once in the list of snippets to 
select it, then pick the option you want from the ‘Preferred menu display 
style’ pulldown at the bottom.
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Use the display style pulldown to specify how you 
want your snippet to be displayed in the menu.



Please note: the default display style is different 
from that of previous versions. In TypeIt4Me 5.5.x 
and earlier, the default was to display only the 
abbreviation in the menu. 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Selecting a snippet, giving it a “My work number” label 
and picking the ‘Show both’ option from this pulldown…

…will give you this result in  
the point-and-click menu



2.13 - Sorting and searching abbreviations and snippets


Over time, you may build a substantial library of shorthand abbreviations. It’s not uncommon for 
TypeIt4Me sets to contain hundreds or even thousands of snippets. This could grow problematic 
to manage if it weren’t for…the humble sort button and its stalwart partner the search filter. These 
two controls can be invaluable for taming large snippet libraries. Between them, they can help you 
to zero in and find specific snippets you may be looking to edit or remove.


2.13.1 Ways you can sort


Snippets can be sorted using any of the following criteria:


• Abbreviation (alphabetical or reverse alphabetical order) 

• Snippet (alphabetical or reverse alphabetical order) 

• Custom (drag individual snippets into your preferred order) 

• Date created (newest at the top) 

• Date modified (most recently modified at the top) 

• Date last used (most recently expanded abbreviations at the top) 

• Use frequency (most frequently used snippets at the top) 

• Label (alphabetical order) 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Search filterSort button



When you select “Sort by abbreviation” or “Sort by snippet”, the relevant column header will 
display an upward arrow ( ^ ) indicating the alphabetical sort order, with symbols at the top, 
followed by numbers and finally the letters A through Z. To reverse the sort order, click once on 
the column header. The upward arrow will change to a downward arrow to reflect the order.


2.13.2 Search your abbreviations and snippets by sorting


Looking for a specific snippet? When the snippets list is alphabetically sorted by snippet, typing a 
few letters will scroll the list to the first snippet that starts with those letters. When sorted by any 
other criteria, the list will scroll to reveal the first abbreviation that starts with the letters you type. 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2.13.3 Search your abbreviations and snippets by filtering


Type one or more letters into the filter field and the list of snippets will shrink to show only snippets 
that contain the combination of letters you typed - anywhere in the abbreviation or the snippet 
contents. As shown here, with the bundled Examples set active typing the letters em into the filter 
narrows the list down to three snippet results. The first and last results in the list contain the letters 
em in their abbreviations (eml and thxem), while the middle result - a latin dummy copy snippet -  
appears because in the contents of the snippet the letters em are found in the latin word Lorem. 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2.13.4 Search and insert snippets using the floating search window


As of TypeIt4Me 6.0 you can assign a “Search snippets” keyboard shortcut in Preferences > 
HotKeys to summon up a snippet search window that floats over whichever app you’re using. Typing 
in Mail and can’t remember the abbreviation you defined for your work address? Just hit the search 
hotkey and type part of your address into the floating search field that appears (or perhaps the word 
“work” if that’s what you labelled the snippet). Use the arrow keys to move through the list of results 
and hit the return key to insert the snippet you want. To dismiss the search window without 
expanding anything, just press the hotkey again. It works as a toggle.








Page  of 59 101

NB: this search feature is only available when you have 
TypeIt4Me set to *not* show in the Dock. If you have set 
TypeIt4Me to be displayed in your Dock but you want to 
be able to use the snippet search window, first you need 
to go to Preferences > General and in the “Icon display” 
section select “Show TypeIt4Me in: Menu bar” (click the 
middle radio button). Then go to Preferences > HotKeys 
and you’ll be able to assign a “Search snippets” key to 
bring up the search window.



2.14 - “What does the Insert menu do?”


The Insert menu directly below the main snippet editing field enables you to craft more sophisticated 
snippets. These might produce fill-in-the-blanks placeholder ‘prompts’ when expanded or perhaps 
use arithmetical formulae to expand to dynamically generated, context-aware snippets. You can do 
things like automatically insert a date that’s two weeks from now without having to work out what it 
will be. You can also embed special characters, nest snippets or even execute complex Applescripts 
when you type an abbreviation.


2.14.1 Insert the current date


Let’s look at how you might go about creating a snippet 
that expands to the current date. First, bring up the main 
app window and click on the + ("add") button underneath 
the list of snippets. A fresh abb / snippet entry will appear 
at the bottom of the list and the focus will move to the 
Abbreviation field. The abb placeholder text can now be 
typed over and replaced with a memorable text shortcut.  
How about dtl or something similar for now? You can 
come back and change this later if you like.
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Type in the new abbreviation. For this example, dtl will stand for date in long format.  
We’re going to make that expand to the current date, e.g. Saturday, December 26, 2020. 


Once you’ve typed dtl in the Abbreviation field, press the 
⇥ (tab) key to progress to the Label field. You can leave 
this blank if you like. For our example, though, we’re 
going to give the snippet a label. This is just to make it 
clearer exactly what the snippet produces in case we 
forget later. Let’s label it Day, Month DD, YYYY as 
shown, to reflect what the output will look like. If you’d 
prefer something different, that’s fine; what’s important is 
that it should make sense to you.


When you’re ready, press the ⇥ key again to progress to 
the main snippet editing field. The snippet placeholder 
text will be selected, ready to be replaced with the 
content of our date snippet. Normally, you’d type or paste 
some ordinary text content over it, but here we’re creating 
a snippet that will automatically produce the current date. 
We need to put in a kind of formula that TypeIt4Me can 
interpret. That’s where the Insert menu comes into play. 

Page  of 61 101



Click on the Insert menu, then roll over the Date 
submenu that pops up to reveal a list of options. 
You’ll see there are a number of pre-cooked date 
format templates you can choose from. If you 
hover over them, each of these will reveal a tooltip 
showing the corresponding syntax* that produces 
it. This typically looks like a string of % symbols 
mixed with letters, numbers and punctuation. 
Clicking one of the options in the list will insert the 
required syntax into your snippet.


Later, when you grow more confident you may 
decide to use the Date and Time menus to roll 
your own custom snippets, mixing and matching 
the individual elements that are separated out in 
the lower three sections of the menu. You can get 
very granular and even choose whether to display 
a leading zero in the month and / or day. For now, 
though, let’s stick to creating our basic Day, Month 
DD, YYYY snippet; it just so happens to match one 
of the provided off-the-shelf templates.
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*It’s actually a standard way to describe the 
elements making up date and time, called strftime. 
But as Leslie Nielsen’s beloved airborne physician 
would say, that’s not important right now.



The long format current date we’re creating for this example corresponds to the fifth option in the 
list of templates, so click on that one. Instead of the snippet placeholder, the main snippet editing 
pane should now contain the following: ⊢%A, %B %e, %Y⊣ (as pictured below). You’ll notice that 
the date syntax is placed within an opening ⊢ and a closing ⊣ container. This is so TypeIt4Me 
knows where the date starts and ends, in case you later decide to add rich text formatting to it. 
Save the snippet - with a ⌘ S, or with the Save button, or by clicking anywhere in the list of 
snippets - and you’re done! Try typing dtl in a text editor or Mail message and watch the date 
magically appear. 


That’s pretty much all there is to it. No more scratching your head trying to remember what day it 
is, fumbling for a calendar or painstakingly typing out the current date. Just rattle off a quick dtl (or 
other abbreviation of your choice) and TypeIt4Me will take care of the rest, spitting out Monday, 
January 4, 2021 (for example) in the blink of an eye. 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Tip: if you want a date to expand in a different 
language from your system language setting, 
place your cursor anywhere in the snippet 
editing area, then select a language from the 
Insert > Date language menu and save. If you 
don’t see the language you want in the list, open 
System Preferences > Languages & Region and 
add it to your preferred languages.



2.14.2 Insert the current time

To insert the current time, we follow the same initial steps 
outlined in section 2.14.1 that covers inserting the current 
date. First, in the main app window click on the + ("add") 
button underneath the list of snippets. A fresh abb / 
snippet entry will appear at the bottom of the list and the 
focus will move to the Abbreviation field. The abb 
placeholder text can now be typed over and replaced with 
a memorable text shortcut.  How about ctm or something 
similar for now? You can always change it later.

 


Type in the new abbreviation. For this example, ctm will stand for current time.  
We’re going to make that expand to the current time in 24h format, e.g. 18:04.


Once you’ve typed ctm in the Abbreviation field, press the 
⇥ (tab) key to progress to the Label field. You can leave 
this blank if you like. For our example, though, we’re 
going to give the snippet a label. This is just to make it 
clearer exactly what the snippet produces in case we 
forget later. Let’s label it Current time (24h clock) as 
shown, to describe what the output will look like. If you’d 
prefer something different, that’s fine; what’s important is 
that it should make sense to you.
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When you’re ready, press the ⇥ key again to progress to the main 
snippet editing field. The snippet placeholder text will be selected, 
ready to be replaced with the content of our time snippet. Normally, 
you’d type or paste some ordinary text content over it, but here we’re 
creating a snippet that will automatically produce the current time. We 
need to put in a kind of formula that TypeIt4Me can interpret to 
produce the desired time stamp. That’s where the Insert menu comes 
into play.


Click on the Insert menu, then roll over the Time submenu that pops 
up to reveal a list of options. You’ll see there are some pre-cooked 
time format templates you can choose from. If you hover over them, 
each of these will reveal a tooltip showing the corresponding syntax* 
that produces it. This typically looks like a string of % symbols mixed 
with letters, numbers and punctuation. Clicking one of the options in 
the list will insert the required syntax into your snippet.


You can mix and match the individual hour, minute and second 
elements that are separated out in the lower four sections of the 
menu. Choose whether to output in 12 or 24h format, whether to 
display an AM/PM suffix and even whether to display a leading zero 
for the hour. For now, let’s stick to creating our 24h time snippet; it just 
so happens to match one of the off-the-shelf templates.
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*The syntax is actually a standard way to 
describe the elements making up date and time, 
called strftime. Consider reading up on it on 
Wikipedia if you ever have trouble sleeping.



The 24h (XX:XX) timestamp we’re creating for this example corresponds to the second option in 
the list of templates, so click on that one. Instead of the snippet placeholder, the main snippet 
editing pane should now contain the following: ⊢%H:%M⊣ (as pictured below). Save the snippet - 
with a ⌘ S, or with the Save button, or by clicking anywhere in the list of snippets - and you’re 
done! Try typing ctm in a text editor or Mail message and watch a timestamp magically appear. 


That’s pretty much all there is to it. Just rattle off a quick ctm (or other abbreviation of your choice) 
and TypeIt4Me will take care of the rest, spitting out 16:48 (for example) in the blink of an eye.  

…What’s that, you say? You want to be able to do more than just insert today’s date and the 
current time? Aha. We thought you might. Read on to learn how to craft some more advanced 
date and time snippets that will automatically produce dates and times at specific points in the 
past or in the future. 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2.14.3 Date and time mathematics

In addition to inserting the current date and time, TypeIt4Me offers 
date and time mathematics. You can set up formulae that will 
calculate a past or future date for you in relation to the present and 
produce that dynamically upon expansion. For example, you might 
wish to create a ‘due date’ abbreviation that expands to Please 
submit your feedback by [a date exactly 3 months from now].


To create that snippet asking people to submit feedback by a due 
date exactly 3 months away, start off the usual way, defining a plain 
text abbreviation (sfdd perhaps) that will expand to the phrase 
Please submit your feedback by (include a space at the end).


All good so far? Great. We’re halfway there already. Next, with the 
cursor still placed at the end of that phrase, click the Insert menu 
and pick a Date format. For this example, let’s go with the second 
option from the top. It includes the named day and month in the 
output, so it will be all the more impressive when you later see 
TypeIt4Me work its arithmetical magic and automatically type  
exactly the right day three months in the future without the need  
for you to calculate it in your head or consult a calendar.
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Your snippet should now look something like this:  Please submit your feedback by ⊢%A, %B %e, %Y⊣

The string of percentage signs and letters tells TypeIt4Me what date format to use when it calculates and 
outputs the date during expansion. 


Next, it’s time to concoct a formula. First, position the cursor anywhere 
inside the opening ⊢ and closing ⊣ containers. Then in the Insert menu, 
pick the Date / Time Math… option. A window will appear that shows the 
current date and time. Underneath that, there will be a number of ‘stepper’ 
buttons that correspond to days (DD), months (MM), years (YY), hours (HH) 
and minutes (MM). These are for specifying how far in the past or future the 
dynamically generated date should be. 


Click on the upward arrow part of the 
MM stepper button three times to add 
three months to the current date (the 
resulting date in relation to the 
present will be displayed above, on 
the right). When you’re done, click 
OK. This will insert a formula in your 
snippet that will output a date exactly 
three months in the future every time 
the snippet is expanded. Click the 
Save button and you’re done.
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With the date and time mathematical formula added, your snippet will look something like this: 

Please submit your feedback by ⊢%A, %B%e, %Y@@@7866000.000000⊣

In this example, now every time you type the abbreviation sfdd TypeIt4Me will expand it to 

Please submit your feedback by [Day, Month Date, Year], dynamically calculating the last part 
upon expansion to produce a date exactly 3 months hence. So if today is Monday, July 15, 2019, 
typing sfdd will produce Please submit your feedback by Tuesday, October 15, 2019.


Now you know how it’s done, you may wish to practice repeating the process and use more of the 
stepper buttons to construct more complex formulae and create abbreviations that will expand to 
various different dates and times of your choosing. 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2.14.4 Embed special characters

When defining your snippets you can use the Insert > Special 
menu (pictured) to embed certain special characters in expanded 
text. The following can be inserted: 


• a special syntax (%| ) to tell TypeIt4Me where to position the 
cursor after expansion. For example: an <st abbreviation could 
be defined as <strong>%|</strong> and would expand to 
<strong></strong> with the cursor placed between the HTML 
tags, ready for you to type the text to be marked up as bold in 
a web page you are editing.


• a special symbol (⌫) to represent a backspace (e.g. if you 
define g to type ⌫ing you'll be able to stick the ing ending to 
any previously typed verb, saving you a keystroke) .


• a special symbol (⇥) to represent a tab that will be typed 
separately from the rest of the snippet (very useful to create 
snippets that fill two or more tab-separated fields or cells) .

• a special symbol (⏎) to represent a Carriage Return (also 

called Enter) that will be typed separately from the rest of the 
snippet. This can be very useful to "press" the Send, OK or 
Login button when filling in forms.
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• a special symbol (⌘) to tell TypeIt4Me to insert the current text content of the clipboard at that position 
(NB: if you ever need to have the ⌘ symbol actually appear in the expanded text, insert two of them next 
to each other when defining the snippet, like so: ⌘⌘).


• a special symbol (℁) which will cause TypeIt4Me to send the entire text of the snippet to AppleScript 
for execution. (Note: if the text is not a valid AppleScript script, expanding the abbreviation will return 
an error. It is up to you to ensure the AppleScript is valid, as TypeIt4Me performs no checks.) 

• a special syntax (%+) to tell TypeIt4Me that it *must* append the trigger that caused the abbreviation 
to expand. This is useful for overriding the general Preferences setting for the Append/Don't Append 
Trigger option on an snippet by snippet basis. For example, if you use a space as a trigger and 
you’ve set your general expansion preferences not to keep the space at the end once snippets have 
been expanded, you can make an exception for an individual snippet by inserting %+ at the end when 
you define that snippet.

• a special syntax (%-) to tell TypeIt4Me *not* to append the trigger that caused the abbreviation to 
expand. Again, this is handy if you want to override the general Preferences. For example, if you use 
a space as a trigger and have stuck with the default TypeIt4Me behaviour of keeping the space at the 
end once snippets have been expanded, you can make an exception for an individual snippet by 
inserting %- at the end when you define that snippet. Doing so will discard the space once you’ve 
expanded that particular snippet. 

 

• a special syntax (✄autocue⌛ ) to tell TypeIt4Me to display the text between the scissors and 
hourglass as a cue, then wait until you press ⇥ to continue. Autocue is explained in the next section.
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• a special syntax (%⚑%) to tell TypeIt4Me to ignore percentage symbols and expand the 
content of the snippet exactly as is. This can be useful if your snippet contains a line of 
programming code that contains percentage symbols that might otherwise be erroneously 
parsed as date syntax.


2.14.5 Set up autocue templates


Autocue is a great time-saving feature that’s popular with power users. It enables you to set 
up templates containing placeholder prompts ("cues") for you to replace with corresponding 
text or data when a particular abbreviation is expanded. 


To include an autocue when defining a snippet, position the cursor in the 
snippet content editing pane where you want it to start, then use the 
Insert > Special menu to insert an autocue. It will initially appear like this: 
✄autocue⌛ . Replace the “autocue” placeholder text that appears in 
between the scissors and hourglass with whatever word(s) you would like 
the temporary prompt to display when you later trigger it. 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NB: once you’ve triggered an autocue snippet and typed over the 
prompt you must press ⇥ (the tab key) to complete the expansion. To 
exit autocue without completing the expansion, press the escape key; 
this will abort the expansion and allow you to carry on typing. 



Let’s look at a hypothetical example of how a doctor writing a letter might use autocue for 
quickly entering a patient’s details in a standard format. S/he could have defined an 
abbreviation, e.g. pdet, that expands to a snippet spread over several lines, with autocues 
inserted to prompt for the patient’s name, date of birth, height and so on.

The abbreviation will expand in stages, with each autocue prompting the doctor and waiting 
for input before proceeding to the next line. So when s/he types pdet TypeIt4Me will begin by 
typing the first line, with the name autocue prompt highlighted ready to be replaced by the 
patient’s name:
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Our doctor types the patient’s name, then presses the ⇥ (tab) key to continue. TypeIt4Me 
expands the next part of the snippet and prompts for the patient’s date of birth in dd/ mm/ yyyy 
format. All the doctor has to do is continue the process, entering details and pressing tab to 
progress to the end, at which point the expansion is complete.

So, when you want to use autocue, just remember that when you type your chosen 
abbreviation TypeIt4Me will expand the text up to the first hourglass symbol, highlight the 
“cue” (the word between the scissors and hourglass symbols) and wait for your input. You’ll 
type the content to replace it and then press ⇥ (tab) to tell TypeIt4Me you’re ready to proceed 
to the next part - if there is one. Just repeat as necessary until you’re done. 
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Note: while TypeIt4Me is awaiting your input during an autocue expansion, you can’t 
expand other abbreviations. Don’t panic, though: you can always exit ‘autocue mode’ 
and cancel the expansion in progress at any time by pressing the esc key.




2.14.6 Nest your snippets 

Using the Snippets submenu, you can embed or “nest” other snippets to appear (expanded of 
course) within the expanded text of any given snippet. Just pick it from the list and it will be 
inserted wherever you’ve positioned the cursor in the snippet you’re editing.

Where they’re inserted in other snippets, in the  
editing pane nested snippets look like this:

Page  of 75 101



2.14.7 Execute Applescript


If you know how to use AppleScript, you can use TypeIt4Me to execute 
a script when you type a shortcut. Just create a new abb / snippet pair 
and type or paste your AppleScript code into the snippet editing pane*. 
Then pull down the Insert > Special menu and pick Execute as 
AppleScript. 


This will place the special symbol ℁ at the beginning of the snippet, 
instructing TypeIt4Me to pass your snippet along to AppleScript for 
execution instead of inserting it.

For example, you could specify that typing opm should open the Mail 
app and have the built-in macOS system voice say "opening Mail":

*Note: take extra care with inverted commas. These must be straight ("), not curly (“), 
otherwise you will run into an error when your Mac attempts to execute the Applescript.


Additionally, in macOS Mojave (10.14) and newer systems, the first time you trigger a 
TypeIt4Me AppleScript snippet you’ll be presented with a system dialog asking you to 
grant permission to execute it. If you don’t click OK your TypeIt4Me AppleScript 
snippets won’t work until you manually grant TypeIt4Me the permissions it requires. 
You can do this in System Preferences > Security & Privacy > Privacy > Automation. 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2.15 - Preferences


Many of TypeIt4Me’s features can be customised to suit your own personal requirements. You can 
tinker with them to your heart’s content via the Preferences section. Don’t want spaces to trigger 
expansion? Looking to disable TypeIt4Me completely in certain apps? Perhaps you’d like to tweak 
spellchecking or have a sound play when abbreviations expand. It’s possible to do all that and a 
whole lot more. The Preferences section is where you’ll set everything up just the way you like it.


The app’s preferences are organised under these seven tabs:

General - Triggers - Expansion - AutoCorrect - Special - HotKeys - Sync

Over the next few pages, we’ll explore the various options available to you. If some of this sounds a 
little jargon-y, don’t worry too much about trying to understand and retain what everything does. As 
long as you get the gist of the kind of things TypeIt4Me can do, you can always refer back to this 
section later and experiment when there’s something specific you’re trying to achieve. Chances are, 
you’ll leave most of the default settings unchanged. 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2.15.1 General


The first Preferences tab - “General” - groups together an array of high level options.  
Here you can specify whether or not TypeIt4Me should: 


- automatically open every time you log in to your Mac  
(we recommend leaving this option enabled).


- display your snippets in the menu bar so you can browse 
through them and retain the option to insert snippets by 
point-and-click in addition to expanding typed abbreviations.


- display the app icon in the dock, in the menu bar or in both. 
(NB: the floating search window feature outlined in section 
2.13.4 is only available when TypeIt4Me is set to appear in 
just the menu bar. Make sure the middle radio button is 
selected if you plan to use search). 

- Use a different expansion method for shorter plain text 
snippets. By default, TypeIt4Me works by copying and 
pasting your snippets to and from the Clipboard on the fly.  
If you’re working in an environment that inhibits or interferes 
with pasted input and this appears to be causing problems 
with TypeIt4Me, tick the “Don’t use the Clipboard…” option 
here. It will bypass the clipboard and expand snippets 
another way*.  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*Note: this method only works for plain text snippets and because it’s slower, it’s limited to snippets up to a 
maximum of 30-characters in length. You can reduce the maximum if you find it too slow.




2.15.2 Triggers


Under the Triggers tab you’ll find a set of checkboxes you can use to choose one, several or even 
all of 35 different keyboard characters that will act as triggers and cause your abbreviations to be 
expanded as you type. To add or remove a trigger, just tick or untick the checkbox next to it.


This picture shows the default setting, which is that typing a ⇥ (tab) 
or space will trigger expansion. Use the All or None buttons to 
quickly select or deselect all check boxes. 


Expansion without typing a trigger:


If you select None, abbreviations will expand immediately as soon 
as they are typed, without the need to type a trigger. Should you 
elect to go with this setting, you will need to ensure that no two 
abbreviations start with the same letters. Otherwise, the shorter one 
will trigger as soon as you type it, every time.  
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Note: you can set triggers to be included at the end of expanded snippet content (“appended”) or discarded. 
There is a global setting for this (see the next section) but it can be overridden in individual snippets (see p.71).




2.15.3 Expansion


Go to the third preferences tab if you want to tinker with settings that govern how TypeIt4Me 
behaves when expanding your snippets. There are twelve checkbox options from which to 
choose. We’ll give you a rundown of what each one does.


Disable keyboard expansion

This is fairly self-explanatory. If you check this box, TypeIt4Me will no 
longer expand your abbreviations automatically as you type. You’ll only 
be able to expand abbreviations using the point-and-click menu list.


Don’t append trigger

You should check this if you don’t want the character that triggers 
expansion (e.g. a space) to be added to the end of expanded snippets.


Case sensitive expansion

If you check this option you will have to type your abbreviations in 
exactly the same upper and / or lower case format in which they were 
defined or they won’t be expanded. Note that TypeIt4Me will still alert 
you if you attempt to define two identical abbreviations, even if you 
type them in a different case. So, if “ty” already exists, TypeIt4Me will 
intervene to remind you if you later try to define a “TY” abbreviation.
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Don’t match Abb Case
By default, if you type an abbreviation starting with a Capital letter 

or in ALL CAPS then TypeIt4Me will expand the snippet accordingly, so that it 
starts with a Capital letter or is typed in ALL CAPS. If you check it, the “Don’t 
match Abb Case” option stops that from happening.


Strip ’s’ for plurals

The “strip ’s’ for plurals” setting enables you to define an abbreviation only 
once to cover both singular and plural forms. If you check this option, typing 
an abbreviation and adding an s to the end before triggering it will result in 
the expanded snippet also having an s at the end. 


Suppose you define abb as abbreviation. Without this option, you would also 
have to define abbs to produce abbreviations. Either that, or you would have 
to type abb, then a space to trigger the expansion to abbreviation, then a 
backspace and finally type an s at the end of abbreviation. Instead, if you 
choose to strip s for plurals, you’ll be able to type abbs and see it expand to 
abbreviations, without the need to define abbs separately.


Play sound on expansion

Select this option if you’d like to hear a system alert sound every time you trigger an expansion. 
When the checkbox is ticked, a list of available sounds will appear for you to choose from. Power 
users with lots of abbreviations may be driven crazy by constant beeping, but if you only use text 
expansion sparingly and tend to look at the keyboard rather than the screen while typing, it can be 
useful for alerting you to typos triggering unintentional expansion, for example.
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Don’t restore Clipboard

Very rarely, you may run into an issue which causes TypeIt4Me to 
misbehave and consistently produce the contents of the clipboard 
instead of the snippet corresponding to the abbreviation you 
typed. It can happen on older, slower Macs or when many apps 
are open, causing event handling to slow down. Selecting the 
“Don’t restore Clipboard” option will prevent this and ensure you 
always get the right snippet expansion. We don’t recommend 
using this feature unless you have to, however, because it does 
mean every time you expand an abbreviation you’ll lose anything 
that was copied to the clipboard.


Hilite abb to replace

Tick this checkbox if when you undo (⌘ Z) an expansion you’d 
prefer to see the abbreviation you typed come back, highlighted 
and ready to be replaced with something else.


Ignore leading characters 

When this is selected TypeIt4Me will expand your snippet even if its triggering abbreviation is 
immediately preceded by non-whitespace characters. This feature was requested for a very 
specific use case; you probably won’t need it.
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No DOuble CAps 

This feature prevents you from typing two or more consecutive 
letters in uppercase. If you turn this option on, you will have to press 
the capslock key to type OK, US, USA, NASA, etc. Backspacing 
over a letter that has been turned to lowercase will allow you to re-
type it in uppercase. 


Capitalize new sentence. 

Turning this on will automatically turn the first letter you type after 
pressing return to uppercase. Ditto for letters typed after a . ! or ? 
but only when they are followed by a space. Note: when typing the 
first letter in a new document, it will not be capitalized because 
TypeIt4Me can only do so when it “watches” you type punctuation. 
This isn’t a bug, it’s a normal feature constraint. 

All Punctuation Resets Abb 

Enable this option if you want TypeIt4Me to expand abbreviations  
even when they are typed immediately after a punctuation mark.


Show duplicates in picker 

With this enabled, if multiple instances of the same abbreviation exist in active sets - perhaps with 
different snippet content defined for each - typing the abbreviation will bring up a popup window 
from which you can pick which snippet you want to expand. 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Important note: some of the “Extras” 
options may have undesirable side 
effects in certain exceptional 
circumstances. The bottom line is: if 
they work for you, turn them on. If you 
are unhappy with their behaviour, just 
turn them off. They’re entirely optional.



2.15.4 AutoCorrect


TypeIt4Me is primarily concerned with expanding your custom defined abbreviations to longer 
snippets of content. Your abbreviations will of course not be dictionary words themselves, so it 
might not be the best idea for the app to second guess everything you ever type. That said, it 
does offer two flavours of AutoCorrect functionality, accessible under the fourth preferences tab.


Since these days macOS already does a pretty good job of 
spellchecking, both of TypeIt4Me’s AutoCorrect options are 
switched off by default. You can opt to enable just one or 
choose to have both active at the same time; they’re 
complementary to each other.


If you type something that’s not a dictionary word and it’s not a 
defined abbreviation in your active snippet set, either, that’s 
when AutoCorrect kicks in. When both options are enabled, 
TypeIt4Me will first look up your typo in the TidBITS 
AutoCorrect Dictionary (a compendium of commonly misspelt 
words). If it doesn’t find it there, it will ask AppleSpell (the built-
in macOS spell checker provided by Apple) to make a 
suggestion for correction.
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If you place .typeit4me snippet sets in ~/Library/Application Support/TypeIt4Me/AutoCorrect/ they 
will be listed in the popup menu, allowing you to easily change from one to another. By default, 
the menu includes the public domain file made available by TidBITS. 


When you tick the Correct typos with AppleSpell checkbox, a number of extra options will appear 
in the window: No audio feedback, Beep on correcting a typo and Speak the corrected word.

We recommend you turn on audio feedback, 
preferably by having TypeIt4Me speak the 
suggested correction. On selecting either Beep... or 
Speak..., you will be presented with a choice of 
system alerts or system voices. 

You can use the slider to fine tune how 
different the suggested correct word can 
be in relation to your typo. Different users 
will be better served with different settings 
to match the kind of typos they’re prone to 
making. We recommend experimenting 
until you find the setting that suits you.
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To tell TypeIt4Me to leave a specific word alone, add the word to the ignored 
words list. To add a word, click the + button and type the word. To remove a 
word from the list, select it by clicking on it, then click the - button.


…You may not want to keep opening up TypeIt4Me’s AutoCorrect preferences 
every time you need to add a word to ignore. Should that be the case, you 
can define a HotKey to use as a shortcut. The next time TypeIt4Me 
AutoCorrects a word that should have been left alone, press ⌘ Z (undo) and 
while the word you want TypeIt4Me to ignore is highlighted, press the HotKey; 
the word will be added to the ignored words list.


Finally, you can also tell TypeIt4Me to ignore words that are shorter than a 
minimum length that you specify, or those that you type with a capital letter, 
such as proper nouns and acronyms.


Note that AutoCorrect is probably not suited to everyone. It very much depends on the speed and 
style of typing of each individual. If you find it doesn't suit your needs, even after tweaking all the 
settings, just turn it off.  Also note that for AutoCorrect to work, you must select at least one trigger 
(space for example) in the Triggers preferences dialog tab. 
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AutoCorrect in multiple languages 

If you assign a hot key for toggling AutoCorrect on and off and have also enabled more than one 
language in Language & Region System Preferences, TypeIt4Me will cycle through the top three 
languages in the list when you press the hot key.


For example, if you set F5 as the AutoCorrect hot key and your list of languages 
is like the one pictured here, pressing the hot key will switch from English (U.K.) 
to Français. Pressing it again will switch to Deutsch. One more press on the hot 
key will turn AutoCorrect off. The next press on the hot key will bring back British 
English, starting a new cycle. If you tick the “Show language settings in the menu 
bar” box in your AutoCorrect preferences, your current language setting will be 
displayed next to the TypeIt4Me icon, like so:


Note that when you make changes to the Preferred Languages list in System 
Preferences, you will need to relaunch TypeIt4Me for the changes to take effect. 
The languages AppleSpell can check are: English, French, Italian, Spanish, 
German, Dutch, Swedish and Portuguese.  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2.15.5 Special


The Special preference tab is where you can assign special behaviours to TypeIt4Me for when 
you’re typing in specific apps. For each app listed (added by drag and drop or using the + button), 
you can either assign a specific snippet set to use exclusively or you can tell TypeIt4Me not to 
expand at all while you’re typing in that app. To remove an app, select it and click the - button. 

Turn TypeIt4Me off in a specific app

Perhaps you never want TypeIt4Me to expand your abbreviations when you’re 
typing in, say, your password manager app. Just add it to the list using the + 
button. Leave the Special Behaviour field on the default setting, “do not expand”.


Associate a snippet set with a particular app

You can tell TypeIt4Me to expand abbreviations only from one specific snippet set 
when you’re typing in a particular app - i.e. not necessarily the currently active 
set(s). To do this, add the app to the list using the + button, then either drag the 
snippet set file you wish to associate with the app onto the Special Behaviour 
column next to the application’s name, or click the arrows in the middle column 
then select “expand using…” and locate the file.  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2.15.6 HotKeys


Rather than constantly move your mouse or trackpad pointer to click on the TypeIt4Me menu, you 
may wish to use quick keyboard shortcuts to initiate certain TypeIt4Me actions. To set these up, 
head to the sixth preferences tab, HotKeys. Here you can define up to six “hot” keys that when 
pressed will invoke the following menu options: 


• Add a snippet


• Manage snippets


• Search snippets 
(Note that you can only set a shortcut here if you have set 
TypeIt4Me to display its icon *only* in the menu bar. If you’ve set 
the app to show in your dock, search will be disabled.)

• Pause/Resume expansion


• Add a word to the ignored words list

 

• Toggle AutoCorrect on/off  

(Note that if you have more than one language listed in 
International, this hot key will actually cycle through the top three 
listed languages in sequence before reaching the off state.) 


• Go to TypeIt4Me’s Preferences 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2.15.7 Sync

The seventh preference tab is where you’ll find options for sharing 
and syncing your TypeIt4Me snippets across multiple Macs and 
devices, either via the cloud or via a shared local network folder. If 
you’re using a cloud syncing service on your Mac, you can point 
TypeIt4Me to its local folder here to activate the shared / synced 
sets pane in the main app window. You’ll then be able to save 
snippet set(s) in your preferred cloud or shared folder and use the 
same set(s) with more than one machine. The available sync 
options are as follows:


• No sync (To only use snippets in local “”Sets on this Mac.”)

• iCloud Drive  
(Select this if you want to be able to drag snippet sets to  
iCloud Drive so they’ll sync with the TypeIt4Me Touch iOS app. 
They’ll also sync with other Macs on which you use TypeIt4Me.)

 

• Other…  

(Select this to specify a shared local network folder or to point  
TypeIt4Me to your Dropbox / Google Drive / other cloud-linked folder.)


When you select the “Other…” option a window will open in which you can navigate to your preferred folder. After 
you select one and click Done, any snippet sets you now add to “Sets in your shared / sync folder” will be saved in 
there, inside a folder named “TypeIt4Me”. NB: If a colleague or team member has already set up a shared folder on 
your local network that contains TypeIt4Me snippets you want to use, select the “Other…” sync option then navigate 
to and open the *parent directory* that contains the existing folder named “TypeIt4Me.”
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2.16 - How to uninstall TypeIt4Me 


Should you ever wish to completely remove TypeIt4Me from your Mac, it’s a relatively 
straightforward process. Just follow these steps to banish all traces of it for good:


• Quit the app (if it’s running).


• Locate the TypeIt4Me app icon in your Applications folder and move it to the trash.


• Locate the com.typeit4me.TypeIt4MeMenu.plist file and move it to the trash.  
(This file is located in the Preferences folder in your user library. In macOS 10.7 and later 
Apple hides the user library, but you can reveal it by clicking Go in the Finder menu bar and 
holding down the alt / option key on your keyboard.)


• Empty the trash.


This will completely remove TypeIt4Me and your Mac will forget it was ever installed. If you later 
change your mind and re-install TypeIt4Me you’ll need to re-enter your licence code to prevent it 
regularly popping up messages asking you to register. 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3. Troubleshooting & Support


A lot of hard work has gone into ensuring your TypeIt4Me experience will be as trouble-free as possible. That 
said, every app ever developed has the odd hiccup and TypeIt4Me is no exception. If you run into trouble, we 
are of course happy to help wherever we can. If you need to get in touch, use the contact form on our 
website, providing as much detail about your software setup as possible (including app / system version 
numbers) and describe the problem as clearly as you can. Before you do, though, we recommend that you 
consult this troubleshooting section; it could help resolve your issue more quickly. What follows is a list of 
common issues you may encounter, together with potential solutions.


3.1 - Common issues and their solutions


3.1.1 TypeIt4Me is not available after you restart or login


If every time you restart or log in to your Mac you find that TypeIt4Me is not running but you’d like 
it to launch automatically, there’s a simple solution. Launch TypeIt4Me and go to Preferences > 
General, then tick the checkbox in the top left corner that says “Open TypeIt4Me at Login”. With 
that option selected, you won’t need to launch TypeIt4Me manually again.
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3.1.2 TypeIt4Me is running but it’s not expanding typed abbreviations


Sometimes, people report that TypeIt4Me was working normally but then inexplicably stopped expanding 
abbreviations. There are a number of potential causes. If this happens to you, before contacting support 
you may want to try these troubleshooting steps, testing to see if expansion works again after each step:


1. Go to System Preferences > Security & Privacy > Privacy [tab] > Accessibility.  
Click the padlock and enter your password to allow changes, then remove TypeIt4Me  
from the list of apps that can control your computer. Next, re-add TypeIt4Me by  
dragging the app back into the list from your Applications folder. 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2. Quit any other apps that are running. One or more of them may have enabled Secure Event 
Input, which blocks TypeIt4Me from seeing what you type and thereby prevents expansion 
(see pages 41-43 for more about this). 

3. Restart your Mac. This almost always does the trick.


4. Go to the Expansion tab of TypeIt4Me’s Preferences and make sure that the first checkbox, 
“Disable keyboard expansion”, is not selected. It may have been ticked by accident.
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3.1.3 The TypeIt4Me icon is not showing up in the menu bar


If you're not seeing the TypeIt4Me icon in your menubar, don’t panic. There are three possible causes, 
each with a very simple explanation and fix:


• Firstly, TypeIt4Me may not in fact be running, in which case you simply need to relaunch it by double 
clicking it in your Applications folder (or clicking it in the dock if you keep it there).


• Secondly, you may have specified in TypeIt4Me's preferences that the menu bar icon should not be 
visible. Click on TypeIt4Me in your dock, then use the TypeIt4Me menu at the top left corner of your 
screen to open its Preferences. In the icon display section make sure TypeIt4Me is set to show either 
in ‘Menu bar' or in ‘Dock & Menu bar’ (i.e. click the second or third radio button).


• The third possibility is that - though it's still running - TypeIt4Me's icon is being covered by menu items 
because the menubar has become crowded and there are a lot of other icons displayed to the right of 
it. Menubar overcrowding can come about when your screen is not wide enough to accommodate all 
your icons as well as all the menu options for the app that’s currently in use. MS Word and other 
Office applications have lots of menubar options, so you may find this happens when using them.  
 
Fortunately, there are ways to save space and mitigate this. In macOS Sierra and newer systems, 
you can hold down the cmd key and then drag your menu bar icons to rearrange them. You could 
also go into 'System Preferences' > ‘Dock & Menu Bar’ and remove any items that you don’t need, in 
order to free up space. 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3.1.4 “An error occurred” moving sets to the correct iCloud location


If you’ve been using sets stored in iCloud Drive, the first time you launch TypeIt4Me 6.x after updating 
from version 5.5.x it will automatically move your sets to a new, hidden iCloud folder. This is because the 
newest version of TypeIt4Me now makes use of a different iCloud incarnation that can sync with 
TypeIt4Me Touch for iOS. This migration ought to be seamless in most cases, but it’s possible something 
may prevent TypeIt4Me from handling it for you. If this happens, you’ll see the following popup message:

When you see this message, it most likely means there is already a set with the same name in the new, 
hidden iCloud folder (possibly created by one of your other Macs, or by TypeIt4Me Touch on one of your 
iOS devices). Don’t worry, the file is not lost, it just got stuck in a temporary folder en route to its intended 
destination. You’ll find it in your user directory, in a folder named “temp.” All you need to do is: 


1. Rename the file in Finder, giving it a unique name (even just appending a number will do). 

2. Double click it. It will be moved to “Sets on this Mac” in TypeIt4Me. 

3. In TypeIt4Me, drag the renamed set from “Sets on this Mac” to “Sets in iCloud Drive.” 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3.1.5 “The licence code does not match the user name.”


Occasionally, customers report problems when attempting to register TypeIt4Me with their purchased 
licence codes. If during registration you get an error message that says “the licence code does not 
match the user name” but as far as you can tell you entered your details correctly, the first thing to try 
is to restart your Mac and try again. A restart of the machine will usually resolve the issue. If the 
problem persists even after a restart, however, it will likely be for one of three possible reasons:


1. There’s a typo somewhere. Both the user name and the licence code you enter must match 
exactly the ones you were emailed. Both fields are case sensitive and any extra blank spaces 
included by accident can cause an error. Rather than typing them in manually, copy and paste 
the user name and licence code carefully, exactly as they were emailed to you. 

2. You may be attempting to register an older software version with a licence code issued for a 
newer version, or vice versa. Check the email you received that contains your user name and 
licence code. This will tell you the software version for which your licence is valid. You may 
need to click on “check for updates” in the TypeIt4Me menu and follow the prompts to update 
if it tells you a newer version is available. Or, it could be that you need to purchase an upgrade 
licence to continue using the latest version. If you don’t want to pay for an upgrade, that’s OK, 
you can revert to using an older version for which your licence code remains valid. Older 
TypeIt4Me versions remain available to download at our website.


3. If what you’ve entered in the licence code field begins with the letters ETT then you’ve 
mistakenly entered the transaction reference number from your purchase invoice. Your 
licence code will be a long string of letters and numbers that looks something like this: 
914e608a40142d5b1mcb960ecf51675
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3.2 Support


This guide is designed to provide you with a solid understanding of how TypeIt4Me works. 
Hopefully you’re already well on your way to saving time and effort that would otherwise be spent 
needlessly pecking away at your keyboard. If there’s anything in this documentation that you find 
unclear or if you’d like to give us feedback on the app and suggest improvements, please do use 
the contact form on our website to get in touch and let us know. We’re also standing by to help if 
you’ve lost your licence code or if you’ve run into problems that don’t appear to have been 
covered here. When contacting us, please provide as much detail as possible, including the 
version number of the software you’re using and the macOS version your Mac is running.


We read every support email we receive and we’ll do our best to get back to you within 24 hours, 
if not sooner. Please bear in mind, though, that we are a very small team based in the United 
Kingdom. If you’re in a different time zone that’s several hours behind or ahead of London, it may 
not be possible for us to reply immediately. Likewise, if you happen to contact us during an 
exceptionally busy period it may sometimes take a little longer for us to address your issue. It’s 
always a good idea to first check the troubleshooting section of this guide and the TypeIt4Me 
Frequently Asked Questions section at the Ettore Software website. 9 times out of 10 any problem 
you’ve encountered will be a known issue with a documented solution or workaround.


Frequently Asked Questions

There’s a searchable online TypeIt4Me FAQ available at www.ettoresoftware.store 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4. Glossary

If you’re familiar with Macs and macOS in general then hopefully the language used to describe 
how TypeIt4Me works won’t sound too much like alien gobbledegook. We’ve tried to keep it as 
simple as possible and limit the amount of jargon for you to decipher. The following is a short list 
of explanations for terms used in a context that’s quite specific to TypeIt4Me.


Text expansion / Text expander

Text expansion is essentially automatic on-the-fly substitution of short typed 
abbreviations with ‘snippets’ of content. Its name derives from the fact that these 
snippets are usually longer than the abbreviations they replace and thus ‘expand’ upon 
them, producing lengthy words, phrases, reams of boilerplate text or even pictures. A 
text expander is an app that executes text expansion, automatically replacing custom 
defined abbreviations on the fly with snippets of text and / or pictures.


Snippet (aka clipping)

Snippet refers to the full text and / or picture(s) that TypeIt4Me will automatically insert 
in your document when any given abbreviation is expanded. It may also refer to the full 
contents of an expansion together with its corresponding abbreviation as a defined 
pairing constituting a single unit, e.g. “there are 15 snippets in the set” can mean “there 
are 15 abbreviation / snippet pairs in the set”. In earlier versions of TypeIt4Me snippets 
were referred to as “clippings”, because they are items of content that are copied to 
and from the Mac’s clipboard.
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Abbreviation (aka shortcut)

This is the text you will type (or pick from a list in the TypeIt4Me menu) in order to 
have a snippet “expanded” (inserted at the cursor) in the document or text field in 
which you’re typing. It’s called an abbreviation because it’s usually shorter than the 
content it represents, but this does not always have to be the case. A jyn 
abbreviation could “expand” to a Japanese yen currency symbol, for example, to 
save you having to remember the standard key combo that usually produces it on 
a non-Japanese keyboard.


Snippet set

In TypeIt4Me a snippet set is a file containing a list of abbreviations and their 
corresponding snippets. In the Mac Finder these appear as files with the extension 
“.typeit4me”. By default, local “Sets on this Mac" are stored in folder in TypeIt4Me’s 
Application Support folder within your User Library, but you can also opt to store them 
in iCloud or in a shared network folder, for example.


Trigger

A trigger is a key on your keyboard that when typed directly after a TypeIt4Me 
abbreviation will cause it to be expanded. There are a total of 35 potential trigger 
keys from which you can choose. Most of them are punctuation keys and symbols.
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Delimiter

A delimiter is a punctuation or symbol character that can be used as a trigger 
that will expand your typed abbreviations when pressed.


Sync / syncing

Sync is short for synchronise / synchronisation. Where we refer to “sync services” 
and “sync options”, we mean  services like iCloud Drive, Dropbox and Google 
Drive. Keeping your snippet sets in sync across multiple Macs means ensuring that 
changes made to a snippet set on one Mac are automatically available on all your 
other Macs that have been set up to use the same sync service and set.
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